Abstract

GlobalViewer Enterprise (GVE) software simplifies AV system resource management with intuitive control for hundreds of common AV tasks. It provides a powerful, flexible way to manage, monitor, and control Extron and third-party AV devices over a standard network. In addition, GVE provides agility and flexibility for support teams to access usage data, create reports, and control the system from any computer on the network. The Help Desk view offers a look at the entire enterprise in a single window and access to detailed room data and control with one click of a mouse.

This document describes the recommended system requirements for GVE and suggested procedures to ensure the user is able to make use of the full potential of the software.

The RoomAware Outlook Add-in is a new feature that automatically switches on room AV systems in preparation for a meeting and switches them off automatically when the meeting ends. For information about using Extron RoomAware, see the RoomAware Outlook Add-in Setup Guide.

Figure 1. GlobalViewer Enterprise

Introduction

GVE is an enterprise-scale Web-based AV resource management application with a SQL Server backend. It extends the functionality of the free GlobalViewer application and leverages the security, data, and access control capabilities of Microsoft Windows Server.

GVE supports configured and programmed control systems:

- IP Link control systems configured with Global Configurator 3.5.2 or later
- Pro Series control systems configured with Global Configurator Plus and Global Configurator Professional 1.3 or later
- Pro Series control systems programmed with Global Scripter 1.0 or later and available Global Scripter module (call your Extron GVE representative to obtain the latest module).

Before starting, you should be familiar with the fundamentals of GVE, as well as Global Configurator (GC), Global Configurator Plus and Professional (GCP), Free GlobalViewer, and Global Scripter. For more information on these software products, go to:

- http://www.extron.com/gve
- http://www.extron.com/globalconfigurator
- http://www.extron.com/free/globalviewer
- http://www.extron.com/globalscripter

This document is based on the requirements for GVE v2.7 installation.
GVE Software Requirements:

Web Server/Operating System

The server on which the GVE web files are installed should be set up and capable of running 24 hours a day, 7 days a week. The reason for this is that GVE logs all changes to the database and runs schedules and checks for monitors continuously.

NOTE: Microsoft IIS (Internet Information Services) must be enabled on the server for the GVE to be installed successfully.

Below are listed the server roles and features of Windows Server 2012 that are required for GVE versions 2.0 and higher.

Server Roles

- Web Server (IIS)
  - Common http features
    - Default Document
    - Directory Browsing
    - HTTP Errors
    - Static Content
  - Health and Diagnostics
    - HTTP Logging
  - Performance
    - Static Content Compression
  - Security
    - Request Filtering
    - Windows Authentication
  - Application Development
    - .NET Extensibility 3.5
    - .NET Extensibility 4.5
    - ISAPI Extensions
    - ISAPI Filters

- IIS Hostable Web Core
- Management Tools
  - IIS Management Console
  - IIS 6 Management Compatibility
    - IIS 6 Metabase Compatibility
  - IIS 6 Management Console
  - IIS 6 Scripting Tools
  - IIS 6 WMI Compatibility
  - IIS Management Scripts and Tools
  - Management Service

Features

- .NET Framework 3.5 Features
  - .NET Framework 3.5 (includes .NET 2.0 and 3.0)
  - HTTP Activation
  - Non-HTTP Activation
- .NET Framework 4.5 Features
  - .NET Framework 4.5
  - ASP.NET 4.5
  - WCF Services
    - HTTP Activation
    - TCP Port Sharing

- User Interfaces and Infrastructure
  - Graphical Management Tools and Infrastructure
  - Server Graphical Shell
- Windows Process Activation Service
  - Process Model
  - .NET Environment 3.5
  - Configuration APIs
- WoW64 Support

User Accounts

Windows domain account:

Extron recommends creating a dedicated Windows domain account for use with GVE with the following properties:

- The account must be a member of the administrator group on the GVE Web server.
- The account must have access rights to SQL, Active Directory, and scheduling servers as needed.
**SQL user account:**

Extron recommends creating a dedicated SQL account called GVE with dbCreator and SysAdmin rights.

**NOTE:** GlobalViewer Enterprise only creates and overwrites a database named “GVE”.

---

**Figure 2. SQL Server Setup**

**SQL Server Database**

All GVE configuration data is stored in the SQL Server database. Extron recommends that this database is on a different machine and is managed by the network administrator. The database administrator should implement and manage regular database backups.

**Active Directory**

Make sure the dedicated Windows domain account has access to the Active Directory server and LDAP ports 389 and 636 are open.

An LDAP connection string is required to integrate GVE with the Active Directory. Below is an example of an LDAP connection string for an Active Directory server with a Fully Qualified Domain Name (FQDN) of PM-DC1.pm.com and a user container Users:

```plaintext
LDAP://PM-DC1.pm.com/CN=Users,DC=pm,DC=com
```

**NOTES:**

- `CN=Users` is required for group-based authentication.
- If the dedicated domain user account for GVE server is managed in Active Directory, then the LDAP string is automatically provided during the GVE installation.
- Extron strongly recommends using HTTPS to access GVE in order to encrypt all user names and passwords before they are transmitted over the network. An SSL certificate is required for HTTPS to work.

---

**Figure 3. GVE Active Directory Settings**

**Calendar Access**

GVE allows users to integrate their room calendar information with GVE.
R25 and 25Live Requirements

- R25 or 25Live Web service must be installed and running for GVE to download room calendar and scheduling information from the R25 or 25Live server.
- A dedicated domain user account is required to access the R25 server.

Office365 and Exchange Server Requirements

- GVE requires an Exchange Web Service component be installed and working. This can be checked by opening the following URL in Internet Explorer:
  https://<server hostname/IP address>/EWS/Exchange.asmx
- GVE requires the Exchange server to allow web access to the Exchange Web Service (EWS).
- Exchange Web Service component via HTTPS — the HTTPS certificate must be a valid registered certificate. The server URL for the Exchange EWS component, as well as the domain name of their exchange server, for example: extron.com, are needed.
- A domain user account and password are required to log in to the Exchange server via the EWS Web page.
- The user must provide the user principal name (that is username@domain).
- The user must provide a room path and mailbox.
- GVE requires the domain user account, the account GVE uses to access Exchange, to have permission to access all mailbox resource accounts by setting up the domain user account so it can impersonate all Exchange resource accounts (see http://msdn.microsoft.com/en-us/library/bb204095(EXCHG.80).aspx for more information).

**NOTE:** Web Service is an optional component and is not part of the WebViewer. See the documentation provided by your scheduling provider for more information on installing and setting up the web service for calling schedule data.

**NOTES:** For e-mail settings, using Office 365:

- The e-mail server must be smpt.office365.com.
- The to and from e-mail address must be from the same domain.
- The User name must belong to the same domain as the to field.
- The Enable SSL check box must be selected.
- Port must be 587.

iCalendar Requirements

- Calendar data must be exported (.ics file) to a webserver to allow GVE remote access.
- Exporting of calendar data should be automated to reflect current scheduling in GVE.
- See the GVE Setup Guide for iCalendar for more information.

Google Calendar Requirements

- Google account administrator must create a service account and credentials (private key).
- Google account administrator must delegate domain-wide authority to the newly created service account.
- The service account private key must be saved in Windows Store on GVE Server.
- See the GVE Setup Guide for Google Calendar for more information.
iGVE Requirements

You must use iGVE 2.4.0 or newer.

For IIS to work with the GVE new mobile service, the user must verify the following settings:

1. Verify the Windows Authentication module is installed in the IIS Web service.
2. Verify the Windows Authentication module is disabled for the GVE website.
3. If using Windows 2008 with IIS 7, verify the Windows Authentication module is installed as part of the IIS Roles.
4. For both IIS 6 and 7, make sure that Windows Authentication directory security for the GVE website is disabled.

**NOTE:** iOS v7.0 or later is required for iGVE 2.4.0.

![Figure 4. iGVE](image)

Network and Services Requirements:

GVE Server Requirements

<table>
<thead>
<tr>
<th>Minimum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
</tr>
<tr>
<td>Database</td>
</tr>
<tr>
<td>Web Server</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>CPU</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Memory</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Free Disk Space</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

Supported Web Browsers

- Internet Explorer 11 or later
- Chrome latest
- Microsoft Edge
- Safari 9 or later
- Firefox latest
Figure 5. Supported Web Browsers

Network Port Requirements

The diagram below and the table on the following page show the network ports and protocols are required for communication between the GVE server environment and control hardware. Consult your network administrator to confirm the network connectivity for the following network ports:

Figure 6. Network Ports Used by GVE
Extron Controller Requirements:

Extron Recommended Firmware Requirements

GVE may require a firmware update to your Extron products. The following are the recommended firmware versions by the control product family:

<table>
<thead>
<tr>
<th>Extron Controllers (Legacy)</th>
<th>Recommended Firmware Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>IPL T PC1, PC1i</td>
<td>1.16</td>
</tr>
<tr>
<td>IPL T S1, S2, S4, S6, IPL 250, IPL T CR48, SFI244, SF24*</td>
<td>1.17</td>
</tr>
<tr>
<td>MLC 104 IP Series</td>
<td>1.06</td>
</tr>
<tr>
<td>MLC 104 IP Plus Series</td>
<td>1.03</td>
</tr>
<tr>
<td>MLC 226 IP Series</td>
<td>1.10</td>
</tr>
<tr>
<td>System 5 IP Series</td>
<td>2.06</td>
</tr>
<tr>
<td>IPCP 505</td>
<td>1.01</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Extron Pro Controllers</th>
<th>Recommended Firmware Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>HC 404</td>
<td>1.00.0000.b043</td>
</tr>
<tr>
<td>IPCP Pro 250, 350, 350DR, and 550</td>
<td>2.06.0000-b010</td>
</tr>
<tr>
<td>IPL Pro S1, S3, and S6</td>
<td>2.06.0000-b010</td>
</tr>
<tr>
<td>IPL Pro IRS8</td>
<td>2.06.0000-b010</td>
</tr>
<tr>
<td>IPL Pro CR88</td>
<td>2.06.0000-b010</td>
</tr>
<tr>
<td>IN1608 IPCP Series</td>
<td>2.06.0000-b010</td>
</tr>
<tr>
<td>DTP CrossPoint IPCP Series</td>
<td>2.06.0000-b010</td>
</tr>
</tbody>
</table>

NOTES:

- * The IPL T SF24 is a discontinued product but it is still supported in GlobalViewer Enterprise.
- Firmware for these products can be found at: [http://www.extron.com/firmware](http://www.extron.com/firmware). Read the release notes before upgrading the firmware. Upgrades from some older versions require a reset of the device followed by a re-upload of the original Global Configurator project file.
- Before starting any firmware upgrade for any product, it is highly recommended that you download and save a copy of the latest Global Configurator project file that was uploaded to the device. FAQs for firmware upload can be found at [http://www.extron.com/download/files/firmware/fwupgrd-faq.pdf](http://www.extron.com/download/files/firmware/fwupgrd-faq.pdf).

Required GC or GCP Version

GVE 2.7 works with files imported from Global Configurator. The current version can be downloaded from [http://www.extron.com/software](http://www.extron.com/software).

To ensure that the import of the GC or GCP project file is successful, follow these recommendations, which are described in more detail below.

1. Evaluate Global Configurator and Global Configurator Plus and Professional Project Files.
2. Verify GlobalViewer Location and GUI Names.
3. Check Schedules.
4. Check Monitors.
5. Verify Source Input Naming.
6. Verify GVE ID.

Project Files

GVE imports GC and GCP project files separately. It is strongly recommended to review the configuration to ensure an easy and seamless import into GVE.

Since GVE can manage multiple project files and incorporate them into a single location hierarchy, Extron recommends that the user separates these files.

NOTE: Extron recommends that, for systems with more than 50 controllers, you should have separate project files for easier management. For example, a school district that consists of 15 schools, with multiple controllers at each location, can have a separate Global Configurator project file for each individual site.
Schedules

Extron highly recommends that you review these schedules in your Global Configurator project files to determine if they are better suited to be executed from GlobalViewer Enterprise. If you determine this is the case, these schedules should be removed from Global Configurator and the same schedules should be set within GlobalViewer Enterprise to avoid any potential schedule conflict.

![GVE Schedules](image)

**Figure 7. GVE Schedules**

Monitors

**NOTES:**

- GVE can monitor only online and offline detection for GCP controllers.
- GVE provides the same monitoring capability for devices controlled by GCP and devices controlled by GC3.

As with schedules, monitors can also be created at an enterprise-wide level using GVE. For example, GVE can monitor any projector on a campus AV system for lamp hours greater than 2000 to send an e-mail to the campus technician.

Extron highly recommends that you review the monitors in the GC and GCP project files to determine if they are better suited to be executed from GlobalViewer Enterprise. If you determine this is the case, these monitors should be removed from GC and GCP and the same monitors should be set within GlobalViewer Enterprise to avoid any potential monitor conflict.

![GVE Monitors](image)

**Figure 8. GVE Monitors**
Naming Inputs

GVE allows the user to run device input source usage reports, such as month-by-month trend analysis or total hours used. Assigning a descriptive name for each input, such as Laptop, Lectern PC, Blu-Ray, or Document Camera, allows for more useful report analysis, and more accurate configurations of new build outs.

**IP Link Control Processors** — Rename the input on the serial driver configuration tab for any display or projector set to a serial port. Also, disable any of the inputs that are not used by unchecking the input name in the tree list (see figure 9).

**Figure 9.** IP Link Control Processor Configuration

**MediaLink Controllers and System 5 IP Switchers** — Rename the input on the front panel tab by editing the Line 1 and Line 2 fields (see figure 10).

**IP Link Pro Control Processors** — GVE inputs must be provided with names. This configuration must be carried out in GCP (see GCP Requirements for GVE Integration on the next page).

GC and GCP handle commands and actions carried out by input devices differently. Devices set up in GC can be imported directly to GVE. However, devices set up in GCP must be configured to ensure that the commands and actions carried out by the devices are named in a way that matches what is expected in GVE. This configuration must be carried out in GCP (see the Global Configurator Help File for further information).

**Figure 10.** MediaLink Controllers and System 5 IP Switchers Configuration
GCP Requirements for GVE Integration

NOTE: This section provides information about integrating Global Configurator Plus and Professional projects into GVE. For information about integrating GC projects see GlobalViewer Enterprise Help File.

To configure a Global Configurator Plus or Professional project to integrate with GlobalViewer Enterprise:

1. Open Global Configurator Plus or Professional (GCP).
2. From the **Project** Menu, select **Project Properties**. The Project Properties window opens.

![GCP Project Properties Window](image)

3. Select the **GlobalViewer Enterprise Settings** tab (see figure 11, 1).
4. Select the **Enable GVE Settings** checkbox (2). This checkbox allows the user to enable or disable the feature of sending a notification to GVE.

**NOTE:** When the **Enable GVE Settings** checkbox is disabled, a warning dialog box is displayed, informing the user that disabling GVE removes all GVE actions that are configured within the project.

![Warning](image)
GVE ID

GVE uses the GVE ID to identify different projects. GVE ID is essential for GVE 2.7 imports to go through successfully. Global Configurator (GC3) and GCP assign a unique GVE ID by default. This default value should be changed to to make it easier to read in GVE.

- All GCP projects that have the same GVE ID are treated as different parts of the same project.
- All imported rooms are grouped in GVE using the GVE ID of the project they were imported from.

Changing the GVE ID in GC3

![Figure 13. Specify GVE ID Screen (GC3)](image)

Changing the GVE ID in GCP

For projects created in Global Configurator Plus or Professional, GVE ID must be enabled:

1. To change the GVE ID, click on the **Edit** button. A confirmation dialog box opens. Click **Yes** to continue.

   ![Figure 14. Edit GVE ID Confirmation Dialog Box](image)

2. Edit the GVE ID (see figure 15, ①) as desired and click **Save** (②). The new GVE ID is saved.

   **NOTE:** The GVE ID uses only alphanumeric characters. If the desired GVE ID is valid, the user is able to click the **Save** button to apply the ID.

   ![Figure 15. Setting the GVE ID with GCP](image)
GlobalViewer Enterprise Pre-installation Guide

GlobalViewer Editor

The GlobalViewer Editor option opens the GlobalViewer Editor view. In this mode, you can make changes to the GlobalViewer configuration for GVE integration.

1. From the View menu, select GlobalViewer Editor or click the icon in the top menu bar. The GlobalViewer editor opens.
2. Select the GlobalViewer Configuration tab.
3. From the Controllers & Devices section (see figure 16, 1), click and drag an unassigned controller to a folder in the GlobalViewer Locations panel (2).

Figure 16. GlobalViewer Locations
GVE Command Mapping

Once GVE has been enabled and a driver has been added to the configuration, the GVE Command Mapping option is visible in the driver panel. This option allows users to map the driver-supported commands and states to the functions that GVE recognizes. GCP attempts to map the driver commands to the GVE functions automatically (see figure 17 below). However, those commands and states that are not mapped automatically, must be mapped manually so the drivers can be recognized by GVE for reporting.

![Figure 17. GVE Command Mapping](image)

**NOTE:** Verify that all the auto-mapped commands in the GVE Command Mappings view are set appropriately. Function mapping is only visible when the GVE Command Mappings option (see figure 17, (4)) is selected.

1. In the Configuration Palette, select Communication Ports (1).
2. Select a Serial Port (2) or Ethernet Port (3) with a driver assigned.
3. Select the GVE Command Mappings radio button (4).
4. Map the appropriate values, using the drop-down lists in the Status and Control panels.

**NOTE:** Commands that do not apply do not need to be mapped. Unmapped commands result in warnings when the configuration is built, but are expected and can be ignored.
Report GVE Input Command

When the Report GVE Input command is configured and executed, it reports the user-selected input and device to the GVE server. To see the Report GVE Input command display in the Available Command System tab, GVE must be enabled and at least one driver must be assigned to a port.

Define GVE Inputs

After GVE is enabled, the GVE input list (see figure 18, 1) can be updated by renaming, adding, or removing inputs as desired.

**NOTE:** If declared inputs from one project are not identically declared in another project, GVE treats these as different inputs (example: “Bluray,” “Blu-ray or Doc Cam,” or “Doc Cam”).

![Figure 18. Defining GVE Inputs](image-url)
Example: Using the Report GVE Input command via button press

In this example, the user configures the display to report to GVE every time the user presses on the input buttons to switch inputs.

1. From the View menu, select Configuration.
2. Select User Interface from the configuration palette.
3. Add a TouchLink Pro touchpanel with a layout (such as a Single Display Jet template).
4. Select a page from the Pages/Popup drop-down list in the Layout View panel (such as Main VC).
5. Click the Button Actions tab (see figure 19, 1).
6. Select an input button on the layout (for example Laptop, 2).
7. Select the Device tab from the Available Commands panel (3), and the Press tab from the Configured Actions panel (4).
8. Drag the display driver Input action command from the Device tab to the Press tab (5).

![Figure 19. Select an Action Command](image)

9. From the Input parameter drop-down list (see figure 20), select an input (for example, Computer1 RGB).

![Figure 20. Select an Input](image)

10. Select the System tab (see figure 21, 1) in the Available Commands panel and drag the Report GVE Input command for the Laptop to the Press tab (2).

![Figure 21. Using the Report GVE Input command via button press](image)
11. Select a display driver from the **Device** drop-down list (see figure 22, 1).

**NOTE:** If the proper projector, display, or interactive whiteboard is not selected as the device from the drop-down list, the associated input usage data is not recorded by GVE.

![Figure 22. Select a Display Driver](image)

12. Select a GVE input from the **Input** drop-down list (see figure 23, 1).

![Figure 23. Select an Input](image)

13. Repeat steps 5 through 12 for any other input buttons.

**Rebuild and Upload Entire Project File**

At this point you are ready to build and upload your Global Configurator project files. Ensure that you are using the current version of the software, which is available on the Extron website. To help Extron commission GVE efficiently, read and follow all instructions in this document. If you have any questions, contact Extron support at [www.extron.com](http://www.extron.com).